GPS 18
TECHNICAL
SPECIFICATIONS

Garmin International, Inc.
1200 E. 151st Street
Olathe, KS  66062 USA

190-00307-00, Revision D
June 2005
© Copyright 2004–2005
Garmin Ltd. or its subsidiaries
All Rights Reserved

Except as expressly provided below, no part of this manual may be reproduced, copied, transmitted, disseminated, downloaded or stored in any storage medium, for any purpose without the express prior written consent of Garmin. Garmin hereby grants permission to download a single copy of this manual and of any revision to this manual onto a hard drive or other electronic storage medium to be viewed and to print one copy of this manual or of any revision hereto, provided that such electronic or printed copy of this manual or revision must contain the complete text of this copyright notice and provided further that any unauthorized commercial distribution of this manual or any revision hereto is strictly prohibited.

Information in this document is subject to change without notice. Garmin reserves the right to change or improve its products and to make changes in the content without obligation to notify any person or organization of such changes or improvements.

Garmin International, Inc.
1200 East 151st Street,
Olathe, Kansas 66062, U.S.A.
Tel. 913/397.8200 or 800/800.1020
Fax 913/397.8282

Garmin (Europe) Ltd.
Unit 5, The Quadrangle, Abbey Park Industrial Estate,
Romsey, SO51 9DL, U.K.
Tel. 44/0870.8501241
Fax 44/0870.8501251

Garmin Corporation
No. 68, Jangshu 2nd Road,
Shijr, Taipei County, Taiwan
Tel. 886/2.2642.9199
Fax 886/2.2642.9099

Web site address: www.garmin.com

RECORD OF REVISIONS

<table>
<thead>
<tr>
<th>Revision</th>
<th>Revision Date</th>
<th>Description</th>
<th>ECO #</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>4/5/04</td>
<td>Initial Release</td>
<td>--</td>
</tr>
<tr>
<td>B</td>
<td>6/7/04</td>
<td>Revise to include PGRMO</td>
<td>26125</td>
</tr>
<tr>
<td>C</td>
<td>5/24/05</td>
<td>Add GPS 18 LVC-5m and GPS 18-5Hz</td>
<td>31279</td>
</tr>
<tr>
<td>D</td>
<td>6/6/05</td>
<td>Add 38400 baud to field 10 of PGRMC sentence</td>
<td>31511</td>
</tr>
</tbody>
</table>
TABLE OF CONTENTS

1 Introduction ................................................................. 1
   1.1 Cautions ................................................................. 1
   1.2 Limited Warranty ..................................................... 2
   1.3 Features ................................................................. 3
   1.4 GPS 18 Series .......................................................... 4
      1.4.1 GPS 18 USB ....................................................... 4
      1.4.2 GPS 18 PC ........................................................ 4
      1.4.3 GPS 18 LVC, GPS 18 LVC-5m, and GPS 18-5Hz ............. 4
   1.5 Technical Specifications ............................................ 5
      1.5.1 Physical Characteristics ......................................... 5
         1.5.1.1 Size ........................................................... 5
         1.5.1.2 Weight ........................................................ 5
         1.5.1.3 Color ........................................................ 5
         1.5.1.4 Case Material ............................................. 5
         1.5.1.5 Cable Length .............................................. 5
      1.5.2 Electrical Characteristics ...................................... 5
         1.5.2.1 Input Voltage ............................................... 5
         1.5.2.2 Input Current .............................................. 5
         1.5.2.3 CMOS Serial Output Levels ............................. 5
         1.5.2.4 GPS Receiver Sensitivity ............................... 6
      1.5.3 Environmental Characteristics .............................. 6
      1.5.4 GPS Performance ............................................... 6
         1.5.4.1 Receiver ..................................................... 6
         1.5.4.2 Acquisition Times ......................................... 6
         1.5.4.3 Update Rate .............................................. 6
         1.5.4.4 Accuracy .................................................. 6
      1.5.5 Interfaces ........................................................ 7
         1.5.5.1 GPS 18 Electrical Characteristics ...................... 7
         1.5.5.2 Garmin Interface and Garmin USB Protocol ............. 7
         1.5.5.3 GPS 18 PC, GPS 18 LVC, & GPS 18-5Hz Protocols ....... 7
         1.5.5.4 Measurement Pulse Output (GPS 18 LVC & GPS 18-5Hz only) 7
   2 GPS 18 LVC & GPS 18-5Hz Wiring and Pinouts .................. 8
      2.1 GPS 18 LVC & GPS 18-5Hz Pinout ............................ 8
      2.2 GPS 18 LVC & GPS 18-5Hz Wiring Diagrams ................ 8
   3 GPS 18 PC, GPS 18 LVC, & GPS 18-5Hz Software Interface ...... 12
      4.1 Received NMEA 0183 Sentences ............................... 12
         4.1.1 Almanac Information (ALM) ............................... 12
         4.1.2 Sensor Initialization Information (PGRMI) ................. 13
         4.1.3 Sensor Configuration Information (PGRMC) ............... 13
         4.1.4 Additional Sensor Configuration Information (PGRMC1) .. 14
         4.1.5 Output Sentence Enable/Disable (PGRMO) ................ 14
      4.2 Transmitted NMEA 0183 Sentences ............................ 15
         4.2.1 Sentence Transmission Rate ............................... 15
         4.2.2 Transmitted Time ........................................... 16
         4.2.3 Global Positioning System Almanac Data (ALM) ........... 16
         4.2.4 Global Positioning System Fix Data (GGA) ............... 17
         4.2.5 GPS DOP and Active Satellites (GSA) ...................... 17
         4.2.6 GPS Satellites in View (GSV) .............................. 17
         4.2.7 Recommended Minimum Specific GPS/TRANSIT Data (RMC) 18
         4.2.8 Track Made Good and Ground Speed (VTG) .............. 18
1 INTRODUCTION

1.1 CAUTIONS

CAUTION

The GPS system is operated by the government of the United States, which is solely responsible for its accuracy and maintenance. Although the GPS 18 is a precision electronic NAVigation AID (NAVAID), any NAVAID can be misused or misinterpreted, and therefore become unsafe. Use these products at your own risk. To reduce the risk, carefully review and understand all aspects of these Technical Specifications before using the GPS 18. When in actual use, carefully compare indications from the GPS to all available navigation sources including the information from other NAVAIDs, visual sightings, charts, etc. For safety, always resolve any discrepancies before continuing navigation.

FCC Compliance

The GPS 18 complies with Part 15 of the FCC interference limits for Class B digital devices FOR HOME OR OFFICE USE. These limits are designed to provide reasonable protection against harmful interference in a residential installation, and are more stringent than “outdoor” requirements.

Operation of this device is subject to the following conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

The GPS 18 does not contain any user-serviceable parts. Unauthorized repairs or modifications could result in permanent damage to the equipment, and void your warranty and your authority to operate this device under Part 15 regulations.
1.2 LIMITED WARRANTY

This Garmin product is warranted to be free from defects in materials or workmanship for one year from the date of purchase. Within this period, Garmin will at its sole option, repair or replace any components that fail in normal use. Such repairs or replacement will be made at no charge to the customer for parts or labor, provided that the customer shall be responsible for any transportation cost. This warranty does not cover failures due to abuse, misuse, accident or unauthorized alteration or repairs.

THE WARRANTIES AND REMEDIES CONTAINED HEREIN ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES EXPRESS OR IMPLIED OR STATUTORY, INCLUDING ANY LIABILITY ARISING UNDER ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, STATUTORY OR OTHERWISE. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, WHICH MAY VARY FROM STATE TO STATE.

IN NO EVENT SHALL GARMIN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES, WHETHER RESULTING FROM THE USE, MISUSE, OR INABILITY TO USE THIS PRODUCT OR FROM DEFECTS IN THE PRODUCT. Some states do not allow the exclusion of incidental or consequential damages, so the above limitations may not apply to you.

Garmin retains the exclusive right to repair or replace the unit or software or offer a full refund of the purchase price at its sole discretion. SUCH REMEDY SHALL BE YOUR SOLE AND EXCLUSIVE REMEDY FOR ANY BREACH OF WARRANTY.

To obtain warranty service, contact your local Garmin authorized dealer, or call Garmin Product Support at one of the numbers shown below for shipping instructions and an RMA tracking number. The unit should be securely packed with the tracking number clearly written on the outside of the package. The unit should then be sent, freight charges prepaid, to any Garmin warranty service station. A copy of the original sales receipt is required as the proof of purchase for warranty repairs.

Garmin International, Inc.
1200 East 151st Street,
Olathe, Kansas 66062, U.S.A.
Tel. 913/397.8200 or 800/800.1020
Fax 913/397.8282

Garmin (Europe) Ltd.
Unit 5, The Quadrangle, Abbey Park Industrial Estate,
Romsey, SO51 9DL, U.K.
Tel. 44/0870.8501241
Fax 44/0870.8501251
Overview

The GPS 18 series products include an embedded receiver and an antenna. Based on the proven technology found in other Garmin 12-channel GPS receivers, the GPS 18 tracks up to 12 satellites at a time while providing fast time-to-first-fix, precise navigation updates (five times per second for the GPS 18-5Hz, and once per second for the GPS 18 USB, 18 PC, and 18 LVC), and low power consumption. This generation of GPS sensors adds the capability of FAA Wide Area Augmentation System (WAAS) differential GPS. The GPS 18’s far-reaching capability meets the sensitivity requirements of land navigation as well as the dynamics requirements of high-performance aircraft.

The GPS 18 design uses the latest technology and high-level circuit integration to achieve superior performance while minimizing space and power requirements. All critical components of the system including the RF/IF receiver hardware and the digital baseband are designed and manufactured by Garmin to ensure the quality and capability of the GPS. The hardware capability combined with software intelligence makes the GPS 18 easy to integrate and use.

The GPS 18 series products are designed to withstand rugged operating conditions and are waterproof to IEC 60529 IPX7, immersion in 1 meter of water for 30 minutes. These complete GPS receivers require minimal additional components to be supplied by an OEM or system integrator. A minimum system must provide the GPS with a source of power and a clear view of the GPS satellites. Internal FLASH memory allows the GPS to retain critical data such as satellite orbital parameters, last-known position, date and time. End user interfaces such as keyboards and displays are the responsibility of the application designer.

1.3 FEATURES

- 12-channel GPS receiver tracks and uses up to 12 satellites for fast, accurate positioning and low power consumption.
- Differential DGPS capability using real-time WAAS corrections yielding position errors of less than 3 meters.
- Compact, rugged design ideal for applications with minimal space. Receiver position information can be displayed directly on a chartplotter or PC.
- User initialization is not required. Once installed, unit automatically produces navigation data after position fix is acquired.
- User-configurable navigation mode (2-dimensional or 3-dimensional fix).
- (GPS 18 LVC and GPS 18-5Hz only) Highly accurate measurement pulse output for precise timing measurements: one-pulse-per-second (1 Hz) for the GPS 18 LVC or 5 Hz for GPS 18-5Hz. Pulse width is configurable in 20 millisecond increments from 20 ms to 980 ms with 1 µs accuracy.
- Configurable for binary format carrier phase data output.
- FLASH-based program and non-volatile memory. New software revisions available through Web site download. Non-volatile memory does not require battery backup.
- Onboard rechargeable backup battery to maintain the real-time clock for up to 3 weeks.
- Configurable parameters include expected position, current time and date, preferred position fix type (2D, 3D, or automatic), and velocity filter time constant (none, automatic, or your choice between 2 and 255 seconds).
- Waterproof design allows continuous exposure to the prevailing weather conditions at most locations.
1.4 GPS 18 SERIES

There are several different versions of GPS 18 available. Refer below for a list of the three major divisions of the GPS 18 Series.

1.4.1 GPS 18 USB

The GPS 18 USB interfaces to a computer with an available USB port. Drivers are available for use on Windows computers. Macintosh and Linux drivers are not available. After the drivers are loaded, the device appears to the Windows operating system as a USB-connected device and appears in Device Manager as a Garmin USB Device.

1.4.2 GPS 18 PC

The GPS 18 PC interfaces to a serial port of a computer via a DB-9 connector and receives power through a 12-volt cigarette lighter adapter. The unit accepts TIA-232-F (RS-232) level inputs and transmits voltage levels that swing from zero V (ground) to 5 V TIA-232-F (RS-232) polarity.

The GPS 18 PC can cause an issue with Windows operating systems if the DB9 connector is plugged into the computer before the navigation software is up and running. The Windows operating system may interpret the serial connector on the GPS 18 as a serial mouse. Please refer to Appendix D: GPS 18 PC/ LVC/18-5Hz & Windows Serial Mouse Issue for complete details.

1.4.3 GPS 18 LVC, GPS 18 LVC-5m, and GPS 18-5Hz

These products interface to a serial port. The units accept TIA-232-F (RS-232) level inputs and transmit voltage levels that swing from ground to the positive supply voltage, TIA-232-F (RS-232) polarity. They also have reverse polarity protection. The cable contains wires for power, ground, receive, transmit, and measurement pulse output.

At the end of the cable, the wires are terminated in a connector that is used by Garmin for testing purposes. Most customers will remove this connector and replace it with another connector of their own choosing. Removing the factory installed connector and/or replacing with another customer-supplied connector will have no affect on the warranty (see Section 1.2 Limited Warranty). The factory-installed connector will mate with JST right-angle PCB-mount connector (model BM06B-SRSS-TBT) or side-entry PCB-mount connector (model SM06B-SRSS-TB). You may obtain technical information on these PCB-mount mating connectors from the JST Web site: http://www.jst.com/.

Note: Unless otherwise specified, all references to the GPS 18 LVC also include the GPS 18 LVC-5m.
1.5 TECHNICAL SPECIFICATIONS
Specifications are subject to change without notice.

1.5.1 Physical Characteristics

1.5.1.1 Size
61 mm in diameter and 19.5 mm in height

1.5.1.2 Weight
- GPS 18 unit only (no cable): 1.9 oz (53.9 g)
- GPS 18 USB: 3.5 oz (100.4 g)
- GPS 18 PC: 6.5 oz (184.6 g)
- GPS 18 LVC (3 meter cable): 3.9 oz (110.6 g)
- GPS 18 LVC-5m (5 meter cable): 5.7 oz (161.6 g)
- GPS 18-5Hz (5 meter cable): 5.7 oz (161.6 g)

1.5.1.3 Color
Black

1.5.1.4 Case Material
Polycarbonate thermoplastic that is waterproof to IEC 60529 IPX7 level (immersion in 1 meter of water for 30 minutes)

1.5.1.5 Cable Length
- GPS 18 USB: 2 meter
- GPS 18 PC: 2 meter
- GPS 18 LVC: 3 meter (Garmin Part Number 010-00321-05)
- GPS 18 LVC-5m: 5 meter (Garmin Part Number 010-00321-06)
- GPS 18-5Hz: 5 meter

1.5.2 Electrical Characteristics

1.5.2.1 Input Voltage
- GPS 18 USB: 4.4–5.5 V
- GPS 18 PC: 8–30 V (Automotive supply from cigarette lighter jack)
- GPS 18 LVC: 4.0–5.5 V
- GPS 18-5Hz: 4.0–5.5 V

1.5.2.2 Input Current
- GPS 18 USB: 55 mA @ 5.0 V
- GPS 18 PC: 50 mA @ 13.8 V
- GPS 18 LVC: 60 mA @ 5.0 V
- GPS 18-5Hz: 65 mA @ 5.0 V

1.5.2.3 CMOS Serial Output Levels
- GPS 18 PC: 0 V to 5 V (Asynchronous Serial, TIA-232-F (RS-232) Compatible Polarity)
- GPS 18 LVC and GPS 18-5Hz: 0 V to Vin, between 4 and 5.5 V (Asynchronous Serial, TIA-232-F (RS-232) Compatible Polarity)
1.5.2.4 GPS Receiver Sensitivity
-165 dBW minimum

1.5.3 Environmental Characteristics
- Operating Temperature: -30°C to +80°C
- Storage Temperature: -40°C to +90°C

1.5.4 GPS Performance

1.5.4.1 Receiver
WAAS enabled; 12 parallel channel GPS receiver continuously tracks and uses up to 12 satellites (up to 11 with Measurement Pulse Output active) to compute and update your position.

1.5.4.2 Acquisition Times
- Reacquisition: Less than 2 seconds
- Warm: Approx. 15 seconds (all data known)
- Cold: Approx. 45 seconds (initial position, time, and almanac known; ephemeris unknown)
- AutoLocate™: 5 minutes (almanac known; initial position and time unknown)
- SkySearch: 5 minutes (no data known)

1.5.4.3 Update Rate
- GPS 18 USB, PC, and LVC: 1 record per second
- GPS 18-5Hz: 5 records per second

1.5.4.4 Accuracy
- GPS Standard Positioning Service (SPS)
  Position: < 15 meters, 95% typical
  Velocity: 0.1 knot RMS steady state
- WAAS
  Position: < 3 meters, 95% typical
  Velocity: 0.1 knot RMS steady state
- Measurement Pulse Output Time: ±1 microsecond at rising edge of the pulse
- Dynamics: 999 knots velocity (only limited at altitude greater than 60,000 feet), 6g dynamics
1.5.5 Interfaces

1.5.5.1 GPS 18 Electrical Characteristics

- **GPS 18 USB:** USB 2.0 full-speed protocol compatible, as well as USB 1.1 full-speed protocol.
- **GPS 18 PC and LVC:** TIA-232-F (RS-232) compatible asynchronous receiver. Default setting is 4800 baud.
- **GPS 18-5Hz:** TIA-232-F (RS-232) compatible asynchronous receiver. Default setting is 19200 baud.

1.5.5.2 Garmin Interface and Garmin USB Protocol


Refer to the *Garmin Device Interface Specification* for details on the Garmin interface. At the time of this printing, these specs are available from the technical support section of our Web site: [http://www.garmin.com/support/commProtocol.html](http://www.garmin.com/support/commProtocol.html).

1.5.5.3 GPS 18 PC, GPS 18 LVC, & GPS 18-5Hz Protocols

- **NMEA 0183 Version 2.0 or NMEA 0183 Version 2.30** (Version 2.0 is factory default, programmable by data field 7 of the PGRMC1 sentence described in Section 4.1.4 Additional Sensor Configuration Information (PGRMC1).

- Available NMEA 0183 output sentences include GPALM, GPGGA, GPGSA, GPGSV, GPRMC, GPVTG, GPGLL, PGRME, PGRMF, PGRMT, PGRMV, and PGRMB (Garmin proprietary sentences). See Section 4.2 Transmitted NMEA 0183 Sentences for format descriptions.

- Configuration and initialization is accomplished with NMEA 0183 input sentences. Allows initialization of information such as expected position, date, time, earth datum, and differential mode. See Section 4.1 Received NMEA 0183 Sentences for format descriptions.

- Configurable for binary data output including GPS carrier phase data.

1.5.5.4 Measurement Pulse Output (GPS 18 LVC & GPS 18-5Hz only)

- **GPS 18 LVC:** 1 Hz pulse with programmable width, configurable in 20 ms increments from 20 ms to 980 ms. See Section 4.1.3 Sensor Configuration Information (PGRMC) for details about configuring the Measurement Pulse Output (or PPS) feature.

- **GPS 18-5Hz:** 5 Hz pulse synchronized with the time of fix. One of the five pulses will align with the UTC second boundary. The pulse width is programmable from 20 ms to 180 ms. The PGRMC sentence will indicate which pulse is at the top-of-the-second. See Section 4.1.3 Sensor Configuration Information (PGRMC) for details about configuring the Measurement Pulse Output (or PPS) feature.

- 1 μs accuracy for all conditions in which the GPS 18 LVC or GPS 18-5Hz has reported a valid and accurate position fix for at least the previous 4 seconds.
The GPS 18 LVC/18-5Hz interfaces to a serial port. The unit accepts TIA-232-F (RS-232) level inputs and transmits voltage levels from ground to the input voltage, TIA-232-F (RS-232) polarity.

The GPS 18 LVC/18-5Hz wires are terminated with a six-wire connector that is used by Garmin for testing purposes. You can remove this connector without voiding your warranty (see Section 1.2 Limited Warranty).

### 2.1 GPS 18 LVC & GPS 18-5Hz PINOUT

<table>
<thead>
<tr>
<th>GPS 18 Pin #</th>
<th>Color</th>
<th>Signal Name</th>
<th>Wire Gauge</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Yellow</td>
<td>Measurement Pulse Output</td>
<td>28</td>
</tr>
<tr>
<td>2</td>
<td>Red</td>
<td>Vin</td>
<td>26</td>
</tr>
<tr>
<td>3</td>
<td>Black</td>
<td>Ground</td>
<td>28</td>
</tr>
<tr>
<td>4</td>
<td>White</td>
<td>Transmit Data</td>
<td>28</td>
</tr>
<tr>
<td>5</td>
<td>Black</td>
<td>Ground</td>
<td>26</td>
</tr>
<tr>
<td>6</td>
<td>Green</td>
<td>Receive Data</td>
<td>28</td>
</tr>
</tbody>
</table>

*Table 1: GPS 18 LVC & GPS 18-5Hz Wire Pinout*

### 2.2 GPS 18 LVC & GPS 18-5Hz WIRING DIAGRAMS

*Figure 1: Computer Serial Port Interconnection*
Figure 2. PDA Serial Port Interconnection

Figure 3. Basic NMEA Device Interconnection
3 MECHANICAL CHARACTERISTICS & MOUNTING

The central threaded recess accepts a metric M3 threaded bolt. The recess is approximately 4 mm deep (4.32 +/- 0.08 mm). The following drawings show example geometries for mounting hardware in case you wish to design your own custom mount. Figure 5 shows mounting geometry for a mount formed from steel sheet metal that is 1.15 mm thick. Figure 7 shows similar mounting geometry for mount formed from aluminum sheet metal that is 1.25 mm thick. Use caution when tightening the mounting bolt. Tightening the mounting bolt can cause the mount to pull tight directly against the metal insert, not against the plastic housing, which would tend to pull the insert out of the plastic. Figure 6 shows the dimensions of our GPS 18 Flush Mount, part number 010-10453-00.

![Figure 4a. GPS 18 Bottom Case Dimensions, Under Mold](image)

![Figure 4b. GPS 18 Bottom Case, Outside of Casing](image)
Figure 5. GPS 18 Suction Cup Mount Center Hole Dimensions

Figure 6. GPS 18 Flush Mount Dimensions

Figure 7. GPS 18 Flush Mount Center Hole Dimensions
4  GPS 18 PC, GPS 18 LVC, & GPS 18-5Hz SOFTWARE INTERFACE

The interface protocol design of the GPS 18 PC, LVC, and GPS 18-5Hz products is based on the National Marine Electronics Association’s NMEA 0183 ASCII interface specification. This standard is fully defined in NMEA 0183, Version 2.30. Copies may be obtained from NMEA, www.nmea.org.

In addition to the standard NMEA 0183 sentences, the GPS 18 PC, LVC, and GPS 18-5Hz may also be configured to transmit information over their serial interface using NMEA 0183 compliant Garmin proprietary sentences. These proprietary sentences begin with the characters, “$PGRM”, instead of the characters “$G” that are typical of the standard NMEA 0183 sentences. The characters “$P” indicate that the sentence is a proprietary implementation and the characters and “GRM” indicate that it is Garmin’s proprietary sentence. The letter (or letters) that follow the characters “$PGRM” uniquely identifies that particular Garmin proprietary sentence.

It is also possible to configure the GPS 18 PC, LVC, and GPS 18-5Hz to transmit binary phase data information over their serial interface. See Appendix B: Binary Phase Output Format for details.


The following sections describe the NMEA 0183 data format of each sentence transmitted and received by the GPS 18 PC, LVC, and GPS 18-5Hz products.

4.1  RECEIVED NMEA 0183 SENTENCES

The following paragraphs define the sentences that can be received on the GPS sensors’ port. Null fields in the configuration sentence indicate no change in the particular configuration parameter. All sentences received by the GPS sensor must be terminated with <CR><LF>, the ASCII characters for carriage return (0D hexadecimal) and line feed (0A hexadecimal). The checksum *hh is used for parity checking data and is not required, but is recommended for use in environments containing high electromagnetic noise. It is generally not required in normal PC environments. When used, the parity bytes (hh) are the ASCII representation of the exclusive-or (XOR) sum of all the characters between the “$” and “*” characters, non-inclusive. The hex representation must be a capital letter, such as 3D instead of 3d. Sentences may be truncated by <CR><LF> after any data field and valid fields up to that point will be acted on by the sensor.

4.1.1  Almanac Information (ALM)
The $GPALM sentence can be used to initialize the GPS sensor’s stored almanac information in the unlikely event of non-volatile memory loss or after storing longer than six months without tracking GPS satellites.

$GPALM,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>,<15>*hh<CR><LF>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;1&gt;</td>
<td>Total number of ALM sentences to be transmitted by the GPS sensor during almanac download. This field can be null or any number when sending almanac to the GPS sensor.</td>
</tr>
<tr>
<td>&lt;2&gt;</td>
<td>Number of current ALM sentence. This field can be null or any number when sending almanac to the GPS sensor.</td>
</tr>
<tr>
<td>&lt;3&gt;</td>
<td>Satellite PRN number, 01 to 32</td>
</tr>
<tr>
<td>&lt;4&gt;</td>
<td>GPS week number</td>
</tr>
<tr>
<td>&lt;5&gt;</td>
<td>SV health, bits 17–24 of each almanac page</td>
</tr>
<tr>
<td>&lt;6&gt;</td>
<td>Eccentricity</td>
</tr>
<tr>
<td>&lt;7&gt;</td>
<td>Almanac reference time</td>
</tr>
<tr>
<td>&lt;8&gt;</td>
<td>Inclination angle</td>
</tr>
<tr>
<td>&lt;9&gt;</td>
<td>Rate of right ascension</td>
</tr>
<tr>
<td>&lt;10&gt;</td>
<td>Root of semi major axis</td>
</tr>
<tr>
<td>&lt;11&gt;</td>
<td>Omega, argument of perigee</td>
</tr>
<tr>
<td>&lt;12&gt;</td>
<td>Longitude of ascension node</td>
</tr>
<tr>
<td>&lt;13&gt;</td>
<td>Mean anomaly</td>
</tr>
<tr>
<td>&lt;14&gt;</td>
<td>af0 clock parameter</td>
</tr>
<tr>
<td>&lt;15&gt;</td>
<td>af1 clock parameter</td>
</tr>
</tbody>
</table>
4.1.2  Sensor Initialization Information (PGRMI)

The $PGRMI$ sentence provides information used to initialize the GPS sensor’s set position and time used for satellite acquisition. Receipt of this sentence by the GPS sensor causes the software to restart the satellite acquisition process. If there are no errors in the sentence, it will be echoed upon receipt. If an error is detected, the echoed $PGRMI$ sentence will contain the current default values. Current $PGRMI$ defaults (with the exception of the Receiver Command, which is a command rather than a mode) can also be obtained by sending $SPGRMIE$ to the GPS sensor.

$PGRMI,<1>,<2>,<3>,<4>,<5>,<6>,<7>*hh<CR><LF>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;1&gt;</td>
<td>Latitude, dd.mm.mmm format for GPS 18 PC/LVC; dd.mm.mmmmm format for GPS 18-5Hz (leading zeros must be transmitted)</td>
</tr>
<tr>
<td>&lt;2&gt;</td>
<td>Latitude hemisphere, N or S</td>
</tr>
<tr>
<td>&lt;3&gt;</td>
<td>Longitude, dd.mm.mmm format for GPS 18 PC/LVC; dd.mm.mmmmm format for GPS 18-5Hz (leading zeros must be transmitted)</td>
</tr>
<tr>
<td>&lt;4&gt;</td>
<td>Longitude hemisphere, E or W</td>
</tr>
<tr>
<td>&lt;5&gt;</td>
<td>Current UTC date, ddmmyy format</td>
</tr>
<tr>
<td>&lt;6&gt;</td>
<td>Current UTC time, hhmmss format for GPS 18 PC/LVC; hhmmss.s format for GPS 18-5Hz</td>
</tr>
<tr>
<td>&lt;7&gt;</td>
<td>Receiver Command, A = Auto Locate, R = Unit Reset</td>
</tr>
</tbody>
</table>

4.1.3  Sensor Configuration Information (PGRMC)

The $PGRMC$ sentence provides information used to configure the GPS sensor’s operation. Configuration parameters are stored in non-volatile memory and retained between power cycles. The GPS sensor will echo this sentence upon its receipt if no errors are detected. If an error is detected, the echoed $PGRMC$ sentence will contain the current default values. Current default values can also be obtained by sending $SPGRMCE$ to the GPS sensor.

$PGRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>*hh<CR><LF>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;1&gt;</td>
<td>Fix mode, A = automatic, 2 = 2D exclusively (host system must supply altitude), 3 = 3D exclusively</td>
</tr>
<tr>
<td>&lt;2&gt;</td>
<td>Altitude above/below mean sea level, -1500.0 to 18000.0 meters</td>
</tr>
<tr>
<td>&lt;3&gt;</td>
<td>Earth datum index. If the user datum index (96) is specified, fields &lt;4&gt; through &lt;8&gt; must contain valid values. Otherwise, fields &lt;4&gt; through &lt;8&gt; must be null. Refer to Appendix A: Earth Datum List for a list of earth datum and the corresponding earth datum index.</td>
</tr>
<tr>
<td>&lt;4&gt;</td>
<td>User earth datum semi-major axis, 6360000.000 to 6380000.000 meters (.001 meters resolution)</td>
</tr>
<tr>
<td>&lt;5&gt;</td>
<td>User earth datum inverse flattening factor, 285.0 to 310.0 (10^-9 resolution)</td>
</tr>
<tr>
<td>&lt;6&gt;</td>
<td>User earth datum delta x earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution)</td>
</tr>
<tr>
<td>&lt;7&gt;</td>
<td>User earth datum delta y earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution)</td>
</tr>
<tr>
<td>&lt;8&gt;</td>
<td>User earth datum delta z earth centered coordinate, -5000.0 to 5000.0 meters (1 meter resolution)</td>
</tr>
<tr>
<td>&lt;9&gt;</td>
<td>Differential mode, A = automatic (output DGPS data when available, non-DGPS otherwise), D = differential exclusively (output only differential fixes)</td>
</tr>
<tr>
<td>&lt;10&gt;</td>
<td>NMEA 0183 Baud rate, 1 = 1200, 2 = 2400, 3 = 4800, 4 = 9600, 5 = 19200, 6 = 300, 7 = 600, 8 = 38400 (for GPS 18-5Hz only)</td>
</tr>
<tr>
<td>&lt;11&gt;</td>
<td>Velocity filter, 0 = No filter, 1 = Automatic filter, 2–255 = Filter time constant (for example, 10 = 10 second filter)</td>
</tr>
<tr>
<td>&lt;12&gt;</td>
<td>Measurement Pulse Output, 1 = Disabled, 2 = Enabled</td>
</tr>
<tr>
<td>&lt;13&gt;</td>
<td>Measurement Pulse Output pulse length, (n+1)*20 ms For 18 LVC/PC n = 0 through 48 (max. 980 ms) For GPS 18-5Hz n = 0 through 8 (max. 180 ms) Example: n = 4 corresponds to a 100 ms wide pulse</td>
</tr>
<tr>
<td>&lt;14&gt;</td>
<td>Dead reckoning valid time 1 to 30 sec. for the GPS 18 PC/LVC or 0.2 to 30.0 sec. for the GPS 18-5Hz</td>
</tr>
</tbody>
</table>

All configuration changes take effect after receipt of a valid value except baud rate and Measurement Pulse Output mode. Baud rate and Measurement Pulse Output mode changes take effect on the next power cycle or an external reset event.
4.1.4 Additional Sensor Configuration Information (PGRMC1)
The $PGRMC1 sentence provides additional information used to configure the GPS sensor operation. Configuration parameters are stored in non-volatile memory and retained between power cycles. The GPS sensor will echo this sentence upon its receipt if no errors are detected. If an error is detected, the echoed PGRMC1 sentence will contain the current default values. Current default values can also be obtained by sending $PGRMC1E to the GPS sensor.

$PGRMC1,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>*hh<CR><LF>

| <1> | NMEA 0183 output time 1 to 900 (sec). Not applicable to GPS 18-5Hz, which always outputs data at 5 Hz (200 ms) |
| <2> | Binary Phase Output Data, 1 = Off, 2 = On. |
| <3> | Automatic Position Averaging when Stopped, 1 = Off, 2 = On |
| <4> | No Effect (DGPS beacon frequency: 0.0, 283.5 to 325.0 kHz in 0.5 kHz steps) |
| <5> | No Effect (DGPS beacon bit rate: 0, 25, 50, 100, or 200 bps) |
| <6> | No Effect (DGPS beacon scanning, 1 = Off, 2 = On) |
| <7> | NMEA 0183 version 2.30 mode indicator, 1 = Off, 2 = On |
| <8> | DGPS WAAS mode, W = WAAS Enabled, N = WAAS Disabled |
| <9> | Power Save Mode, P = Power Save mode, N = Normal |
| <10> | Adaptive Transmission Enabled, 1 = Off, 2 = On |
| <11> | Auto Power Off, 1 = Off, 2 = On |
| <12> | Power On with External Charger, 1 = Off, 2 = On |
| <13> | Measurement Pulse Output Auto Off Mode, 1 = Off, 2 = On |

Configuration changes take effect immediately, with the exception of Binary Phase Output Data, which takes effect on the next power cycle or a reset event. Send the sentence “$PGRMI,,,,,R” to command a reset (refer to Section 4.1.2 Sensor Initialization Information (PGRMI)). If the GPS sensor is in the Binary data mode, it is necessary to send the following eight-byte data stream to temporarily change the data format to NMEA 0183. Then follow by sending a PGRMC1 sentence that turns off the Binary Phase Output Data format:

10 0A 02 26 00 CE 10 03 (Hexadecimal)

4.1.5 Output Sentence Enable/Disable (PGRMO)
The $PGRMO sentence provides the ability to enable and disable specific output sentences. The following sentences are enabled at the factory for the GPS 18 PC and LVC: GPGGA, GPGSA, GPGSV, GPRMC, and PGRMT.

The following sentences are enabled at the factory for the GPS 18-5Hz: GPGGA, GPGSA, GPRMC, GPUTG, and PGRMT.

$PGRMO,<1>,<2>*hh<CR><LF>

| <1> | Target sentence description (for example, PGRMT, GPGSV, etc.) |
| <2> | Target sentence mode, where 0 = disable specified sentence, 1 = enable specified sentence, 2 = disable all output sentences, 3 = enable all output sentences (except GPALM), 4 = restore factory default output sentences |

The following notes apply to the PGRMO input sentence:

1. If the target sentence mode is ‘2’ (disable all), ‘3’ (enable all), or ‘4’ (restore defaults), the target sentence description is not checked for validity. In this case, an empty field is allowed (for example, $PGRMO,,3), or the mode field may contain from 1 to 5 characters.

2. If the target sentence mode is ‘0’ (disable) or ‘1’ (enable), the target sentence description field must be an identifier for one of the sentences that can be output by the GPS sensor.

3. If either the target sentence field or the target sentence description field is not valid, the PGRMO sentence will have no effect.

4. $PGRMO,GPALM,1 will cause the GPS sensor to transmit all stored almanac information. All other NMEA 0183 sentence transmission will be suspended temporarily.

5. $PGRMO,,G will cause the COM port to change to Garmin Data Transfer format for the duration of the power cycle. The Garmin mode is required for GPS 18 series product software updates.
4.2 TRANSMITTED NMEA 0183 SENTENCES

The subsequent paragraphs define the sentences that can be transmitted by the GPS 18 PC and LVC.

4.2.1 Sentence Transmission Rate

Sentences are transmitted with respect to the user selected baud rate.

The GPS sensor will transmit each sentence (except where noted in particular transmitted sentence descriptions) at a periodic rate based on the user selected baud rate and user selected output sentences. The GPS sensor will transmit the selected sentences contiguously. The length of the transmission can be determined by the following equation and Tables 2 and 3:

\[
\text{length of transmission} = \frac{\text{total characters to be transmitted}}{\text{characters transmitted per second}}
\]

<table>
<thead>
<tr>
<th>Sentence</th>
<th>Output by Default?</th>
<th>Maximum Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPRMC</td>
<td>✓</td>
<td>74</td>
</tr>
<tr>
<td>GPGGA</td>
<td>✓</td>
<td>82</td>
</tr>
<tr>
<td>GPGSA</td>
<td>✓</td>
<td>66</td>
</tr>
<tr>
<td>GPGSV</td>
<td>✓ (PC and LVC only)</td>
<td>70</td>
</tr>
<tr>
<td>PGRME</td>
<td>✓ (PC and LVC only)</td>
<td>35</td>
</tr>
<tr>
<td>GPGLL</td>
<td></td>
<td>44</td>
</tr>
<tr>
<td>GPVTG</td>
<td>✓ (18-5Hz only)</td>
<td>42</td>
</tr>
<tr>
<td>PGRMV</td>
<td></td>
<td>32</td>
</tr>
<tr>
<td>PGRMF</td>
<td></td>
<td>82</td>
</tr>
<tr>
<td>PGRMB</td>
<td>✓ (PC and LVC only)</td>
<td>40</td>
</tr>
<tr>
<td>PGRMT</td>
<td>Once per minute</td>
<td>50</td>
</tr>
</tbody>
</table>

Table 2: NMEA 0183 Output Sentence Order and Size

<table>
<thead>
<tr>
<th>Baud</th>
<th>Characters per Second</th>
</tr>
</thead>
<tbody>
<tr>
<td>300</td>
<td>30</td>
</tr>
<tr>
<td>600</td>
<td>60</td>
</tr>
<tr>
<td>1200</td>
<td>120</td>
</tr>
<tr>
<td>2400</td>
<td>240</td>
</tr>
<tr>
<td>4800</td>
<td>480</td>
</tr>
<tr>
<td>9600</td>
<td>960</td>
</tr>
<tr>
<td>19200</td>
<td>1920</td>
</tr>
<tr>
<td>38400</td>
<td>3840</td>
</tr>
</tbody>
</table>

Table 3: Characters per Second for Available Baud Rates

The maximum number of fields allowed in a single sentence is 82 characters including delimiters. Values in the table include the sentence start delimiter character “$” and the termination delimiter <CR><LF>. For the GPS 18 PC and LVC, the factory set defaults result in a once per second transmission at the NMEA 0183 specification transmission rate of 4800 baud. For the GPS 18-5Hz, the factory set defaults will result in a five times per second transmission at 19200 baud.

For the GPS 18 LVC: Regardless of the selected baud rate, the information transmitted by the GPS sensor is referenced to the one-pulse-per-second output pulse immediately preceding the GPRMC sentence, or whichever sentence is output first in the burst (see Table 2 above).

For the GPS 18-5Hz: Regardless of the selected baud rate, the information transmitted by the GPS sensor is referenced to the preceding five times per second output pulse.
4.2.2 Transmitted Time

The GPS sensor outputs UTC (Coordinated Universal Time) date and time of day in the transmitted sentences. Before the initial position fix, the on-board clock provides the date and time of day. After the initial position fix, the date and time of day are calculated using GPS satellite information and are synchronized with the measurement pulse output.

The GPS 18-5Hz outputs a UTC with a tenths-of-a-second precision: 123456.8, for example.

The GPS sensor uses information obtained from the GPS satellites to add or delete UTC leap seconds and correct the transmitted date and time of day. The transmitted date and time of day for leap second correction follow the guidelines in “National Institute of Standards and Technology Special Publication 432 (Revised 1990)” (for sale by the Superintendent of Documents, U.S. Government Printing Office, Washington, D.C., 20402, U.S.A.).

When a positive leap second is required, one second is inserted at the beginning of the first hour (0h 0m 0s) of the day that the positive leap is occurring. The minute containing the leap second is 61 seconds long. The transmitted date and time of day for leap second correction follows:

$GPRMC,235959,A,3851.3651,N,09447.9382,W,000.0,221.9,071103,003.3,E*69$
$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67$
$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67$
$GPRMC,000001,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*66$

If a negative leap second should be required, one second will be deleted at the end of some UTC month. The minute containing the leap second will be only 59 seconds long. In this case, the GPS sensor will not transmit the time of day 0h 0m 0s (the “zero” second) for the day from which the leap second is removed.

$GPRMC,235959,A,3851.3650,N,09447.9373,W,000.0,000.0,111103,003.3,E*69$
$GPRMC,000001,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*6A$
$GPRMC,000002,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*69$

4.2.3 Global Positioning System Almanac Data (ALM)

Almanac sentences are not normally transmitted. Send the GPS sensor a $PGRMO,GPALM,1$ command to initiate almanac transmission. Upon receipt of this command, the GPS sensor will transmit available almanac information on GPALM sentences. During the transmission of almanac sentences, other NMEA 0183 data output is suspended temporarily.

$GPALM,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>,<15>*hh<CR><LF>$

[field information] can be found in Section 4.1.1 Almanac Information (ALM).
### 4.2.4 Global Positioning System Fix Data (GGA)

$GPGGA,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>^*hh<CR><LF>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;1&gt;</td>
<td>UTC time of position fix, hhmmss format for GPS 18 PC or LVC; hhmmss.s format for GPS 18-5Hz</td>
</tr>
<tr>
<td>&lt;2&gt;</td>
<td>Latitude, ddmm.mmmm format for GPS 18 PC/LVC; ddmm.mmmmm for GPS 18-5Hz (leading zeros will be transmitted)</td>
</tr>
<tr>
<td>&lt;3&gt;</td>
<td>Latitude hemisphere, N or S</td>
</tr>
<tr>
<td>&lt;4&gt;</td>
<td>Longitude, dddmm.mmmm format for GPS 18 PC/LVC; dddmm.mmmmm for GPS 18-5Hz (leading zeros will be transmitted)</td>
</tr>
<tr>
<td>&lt;5&gt;</td>
<td>Longitude hemisphere, E or W</td>
</tr>
<tr>
<td>&lt;6&gt;</td>
<td>GPS quality indication, 0 = fix not available, 1 = Non-differential GPS fix available, 2 = Differential GPS (WAAS) fix available, 6 = Estimated</td>
</tr>
<tr>
<td>&lt;7&gt;</td>
<td>Number of satellites in use, 00 to 12 (leading zeros will be transmitted)</td>
</tr>
<tr>
<td>&lt;8&gt;</td>
<td>Horizontal dilution of precision, 0.5 to 99.9</td>
</tr>
<tr>
<td>&lt;9&gt;</td>
<td>Geoidal height, -999.9 to 9999.9 meters</td>
</tr>
<tr>
<td>&lt;10&gt;</td>
<td>Geoidal height, -999.9 to 99999.9 meters</td>
</tr>
<tr>
<td>&lt;11&gt;</td>
<td>Null (Differential GPS)</td>
</tr>
<tr>
<td>&lt;12&gt;</td>
<td>Null (Differential Reference Station ID)</td>
</tr>
</tbody>
</table>

### 4.2.5 GPS DOP and Active Satellites (GSA)

$GPGSA,<1>,<2>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<4>,<5>,<6>^*hh<CR><LF>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;1&gt;</td>
<td>Mode, M = manual, A = automatic</td>
</tr>
<tr>
<td>&lt;2&gt;</td>
<td>Fix type, 1 = not available, 2 = 2D, 3 = 3D</td>
</tr>
<tr>
<td>&lt;3&gt;</td>
<td>PRN number, 01 to 32, of satellite used in solution, up to 12 transmitted (leading zeros will be transmitted)</td>
</tr>
<tr>
<td>&lt;4&gt;</td>
<td>Position dilution of precision, 0.5 to 99.9</td>
</tr>
<tr>
<td>&lt;5&gt;</td>
<td>Horizontal dilution of precision, 0.5 to 99.9</td>
</tr>
<tr>
<td>&lt;6&gt;</td>
<td>Vertical dilution of precision, 0.5 to 99.9</td>
</tr>
</tbody>
</table>

### 4.2.6 GPS Satellites in View (GSV)

$GPGSV,<1>,<2>,<3>,<4>,<5>,<6>,<7>,...<4>,<5>,<6>,<7>^*hh<CR><LF>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;1&gt;</td>
<td>Total number of GSV sentences to be transmitted</td>
</tr>
<tr>
<td>&lt;2&gt;</td>
<td>Number of current GSV sentence</td>
</tr>
<tr>
<td>&lt;3&gt;</td>
<td>Total number of satellites in view, 00 to 12 (leading zeros will be transmitted)</td>
</tr>
<tr>
<td>&lt;4&gt;</td>
<td>Satellite PRN number, 01 to 32 (leading zeros will be transmitted)</td>
</tr>
<tr>
<td>&lt;5&gt;</td>
<td>Satellite elevation, 00 to 90 degrees (leading zeros will be transmitted)</td>
</tr>
<tr>
<td>&lt;6&gt;</td>
<td>Satellite azimuth, 000 to 359 degrees, true (leading zeros will be transmitted)</td>
</tr>
<tr>
<td>&lt;7&gt;</td>
<td>Signal to noise ratio (C/No) 00 to 99 dB, null when not tracking (leading zeros will be transmitted)</td>
</tr>
</tbody>
</table>

**NOTE:** Items <4>, <5>, <6>, and <7> repeat for each satellite in view to a maximum of four (4) satellites per sentence. Additional satellites in view information must be sent in subsequent bursts of NMEA 0183 data. These fields will be null if unused.
4.2.7  Recommended Minimum Specific GPS/TRANSIT Data (RMC)

$GPRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>*hh<CR><LF>

- **<1>** UTC time of position fix, hhmmss format for GPS 18 PC/LVC; hhmmss.s format for GPS 18-5Hz.
- **<2>** Status, A = Valid position, V = NAV receiver warning.
- **<3>** Latitude, ddmm.mmm format for GPS 18 PC/LVC; ddmm.mmmmm format for GPS 18-5Hz (leading zeros must be transmitted).
- **<4>** Latitude hemisphere, N or S.
- **<5>** Longitude, ddmm.mmm format for GPS 18 PC/LVC; ddmm.mmmmm format for GPS 18-5Hz (leading zeros must be transmitted).
- **<6>** Longitude hemisphere, E or W.
- **<7>** Speed over ground, GPS 18 PC and LVC: 000.0 to 999.9 knots, GPS 18-5Hz: 000.00 to 999.99 knots (leading zeros will be transmitted).
- **<8>** Course over ground, 000.0 to 359.9 degrees, true (leading zeros will be transmitted).
- **<9>** UTC date of position fix, ddmmyy format.
- **<10>** Magnetic variation, 000.0 to 180.0 degrees (leading zeros will be transmitted).
- **<11>** Magnetic variation direction, E or W (westerly variation adds to true course).
- **<12>** Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous, D = Differential, E = Estimated, N = Data not valid.

4.2.8  Track Made Good and Ground Speed (VTG)

$GPVTG,<1>,T,<2>,M,<3>,N,<4>,K,<5>*hh<CR><LF>

- **<1>** True course over ground, GPS 18 PC and LVC: 000 to 359 degrees, GPS 18-5Hz: 000.0 to 359.0 degrees (leading zeros will be transmitted).
- **<2>** Magnetic course over ground, 000 to 359 degrees, GPS 18-5Hz: 000.0 to 359.0 degrees (leading zeros will be transmitted).
- **<3>** Speed over ground, GPS 18 PC and LVC: 000.0 to 999.9 knots, GPS 18-5Hz: 000.00 to 999.99 knots (leading zeros will be transmitted).
- **<4>** Speed over ground, GPS 18 PC and LVC: 0000.0 to 1851.8 kilometers per hour, GPS 18-5Hz: 0000.00 to 1851.89 (leading zeros will be transmitted).
- **<5>** Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous, D = Differential, E = Estimated, N = Data not valid.

4.2.9  Geographic Position (GLL)

$GPGLL,<1>,<2>,<3>,<4>,<5>,<6>,<7>*hh<CR><LF>

- **<1>** Latitude, ddmm.mmm format for GPS 18 PC/LVC; ddmm.mmmmm format for GPS 18-5Hz (leading zeros must be transmitted).
- **<2>** Latitude hemisphere, N or S.
- **<3>** Longitude, ddmm.mmm format for GPS 18 PC/LVC; ddmm.mmmmm format for GPS 18-5Hz (leading zeros must be transmitted).
- **<4>** Longitude hemisphere, E or W.
- **<5>** UTC time of position fix, hhmmss format for GPS 18 PC/LVC; hhmmss.s format for GPS 18-5Hz.
- **<6>** Status, A = Valid position, V = NAV receiver warning.
- **<7>** Mode indicator (only output if NMEA 0183 version 2.30 active), A = Autonomous, D = Differential (WAAS), E = Estimated, N = Data not valid.
4.2.10 Estimated Error Information (PGRME)
$PGRME,<1>,M,<2>,M,<3>,M*hh<CR><LF>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;1&gt;</td>
<td>Estimated horizontal position error (HPE), 0.0 to 999.9 meters</td>
</tr>
<tr>
<td>&lt;2&gt;</td>
<td>Estimated vertical position error (VPE), 0.0 to 999.9 meters</td>
</tr>
<tr>
<td>&lt;3&gt;</td>
<td>Estimated position error (EPE), 0.0 to 999.9 meters</td>
</tr>
</tbody>
</table>

4.2.11 GPS Fix Data Sentence (PGRMF)
$PGRMF,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>,<15>*hh<CR><LF>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;1&gt;</td>
<td>GPS week number (0 to 1023)</td>
</tr>
<tr>
<td>&lt;2&gt;</td>
<td>GPS seconds (0 to 604799)</td>
</tr>
<tr>
<td>&lt;3&gt;</td>
<td>UTC date of position fix, ddmmyy format</td>
</tr>
<tr>
<td>&lt;4&gt;</td>
<td>UTC time of position fix, hhmmss format for GPS 18 PC/LVC; hhmmss.s format for GPS 18-5Hz</td>
</tr>
<tr>
<td>&lt;5&gt;</td>
<td>GPS leap second count</td>
</tr>
<tr>
<td>&lt;6&gt;</td>
<td>Latitude, ddmm.mmm format for GPS 18 PC/LVC; ddmm.mmmmm format for GPS 18-5Hz (leading zeros must be transmitted)</td>
</tr>
<tr>
<td>&lt;7&gt;</td>
<td>Latitude hemisphere, N or S</td>
</tr>
<tr>
<td>&lt;8&gt;</td>
<td>Longitude, ddmm.mmm format for GPS 18 PC/LVC; ddmm.mmmmm format for GPS 18-5Hz (leading zeros must be transmitted)</td>
</tr>
<tr>
<td>&lt;9&gt;</td>
<td>Longitude hemisphere, E or W</td>
</tr>
<tr>
<td>&lt;10&gt;</td>
<td>Mode, M = manual, A = automatic</td>
</tr>
<tr>
<td>&lt;11&gt;</td>
<td>Fix type, 0 = no fix, 1 = 2D fix, 2 = 3D fix</td>
</tr>
<tr>
<td>&lt;12&gt;</td>
<td>Speed over ground, 0 to 1851 kilometers/hour</td>
</tr>
<tr>
<td>&lt;13&gt;</td>
<td>Course over ground, 0 to 359 degrees, true</td>
</tr>
<tr>
<td>&lt;14&gt;</td>
<td>Position dilution of precision, 0 to 9 (rounded to nearest integer value)</td>
</tr>
<tr>
<td>&lt;15&gt;</td>
<td>Time dilution of precision, 0 to 9 (rounded to nearest integer value)</td>
</tr>
</tbody>
</table>

4.2.12 Sensor Status Information (PGRMT)
The Garmin Proprietary sentence $PGRMT gives information concerning the status of the GPS sensor. This sentence is transmitted once per minute regardless of the selected baud rate.
$PGRMT,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>*hh<CR><LF>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;1&gt;</td>
<td>Product, model and software version (variable length field, for example, “GPS 18 VER 2.05”)</td>
</tr>
<tr>
<td>&lt;2&gt;</td>
<td>ROM checksum test, P = pass, F = fail</td>
</tr>
<tr>
<td>&lt;3&gt;</td>
<td>Receiver failure discrete, P = pass, F = fail</td>
</tr>
<tr>
<td>&lt;4&gt;</td>
<td>Stored data lost, R = retained, L = lost</td>
</tr>
<tr>
<td>&lt;5&gt;</td>
<td>Real time clock lost, R = retained, L = lost</td>
</tr>
<tr>
<td>&lt;6&gt;</td>
<td>Oscillator drift discrete, P = pass, F = excessive drift detected</td>
</tr>
<tr>
<td>&lt;7&gt;</td>
<td>Data collection discrete, C = collecting, null if not collecting</td>
</tr>
<tr>
<td>&lt;8&gt;</td>
<td>GPS sensor temperature in degrees C</td>
</tr>
<tr>
<td>&lt;9&gt;</td>
<td>GPS sensor configuration data, R = retained, L = lost</td>
</tr>
</tbody>
</table>

4.2.13 3D Velocity Information (PGRMV)
$PGRMV,<1>,<2>,<3>*hh<CR><LF>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;1&gt;</td>
<td>True east velocity, -514.4 to 514.4 meters/second for GPS 18 PC/LVC; -514.44 to 514.44 for GPS 18-5Hz</td>
</tr>
<tr>
<td>&lt;2&gt;</td>
<td>True north velocity, -514.4 to 514.4 meters/second for GPS 18 PC/LVC; -514.44 to 514.44 for GPS 18-5Hz</td>
</tr>
<tr>
<td>&lt;3&gt;</td>
<td>Up velocity, -999.9 to 999.9 meters/second for GPS 18 PC/LVC; -999.99 to 999.99 for GPS 18-5Hz</td>
</tr>
</tbody>
</table>
4.2.14 DGPS Beacon Information (PGRMB)

NOTE: The GPS 18 products do not support PGRMB at this time.

$PGRMB,<1>,<2>,<3>,<4>,<5>,K,<6>,<7>,<8>*hh<CR><LF>

|<1>| Beacon tune frequency, 0.0, 283.5 to 325.0 kHz in 0.5 kHz steps |
|<2>| Beacon bit rate, 0, 25, 50, 100, or 200 bps |
|<3>| Beacon SNR, 0 to 31 |
|<4>| Beacon data quality, 0 to 100 |
|<5>| Distance to beacon reference station in kilometers |
|<6>| Beacon receiver communication status (0 = Check Wiring, 1 = No Signal, 2 = Tuning, 3 = Receiving, 4 = Scanning) |
|<7>| DGPS fix source (R = RTCM, W = WAAS, N = Non-DGPS Fix) |
|<8>| DGPS mode, A = Automatic, W = WAAS Only, R = RTCM Only, N = None (DGPS disabled) |

4.3 BAUD RATE SELECTION

Baud rate selection can be performed by sending the appropriate configuration sentence to the GPS sensor as described in the $PGRMC Section 4.1.2 Sensor Initialization Information (PGRMI), field <10>.

4.4 MEASUREMENT PULSE OUTPUT (GPS 18 LVC & 18-5Hz ONLY)

4.4.1 One-Pulse-Per-Second (PPS) Output (GPS 18 LVC Only)

The highly accurate one-pulse-per-second (PPS) output is provided for applications requiring precise timing measurements. After the initial position fix has been calculated, the PPS signal is generated and continues until power down. The rising edge of the signal is aligned to the start of each GPS second within 1 µs for all conditions in which the receiver has reported a valid and accurate position for at least the previous 4 seconds.

The NMEA 0183 sentences that follow each rising edge of the PPS signal tell when you were and where you were at that previous rising edge of the PPS signal, beginning with the GPRMC sentence as the lead sentence in any particular NMEA 0183 record.

Regardless of the selected baud rate, the information transmitted by the GPS 18 series products is referenced to the pulse immediately preceding the NMEA 0183 RMC sentence.

The accuracy of the one-pulse-per-second output is maintained only while the GPS receiver is computing a valid position fix. To obtain the most accurate results, the one-pulse-per-second output should be calibrated against a local time reference to compensate for cable and internal receiver delays and the local time bias.

The default pulse width is 100 ms, however; it may be programmed in 20 ms increments between 20 ms and 980 ms as described in $PGRMC Section 4.1.2 Sensor Initialization Information (PGRMI), field <13>.

4.4.2 Five-Pulse-Per-Second Output (GPS 18-5Hz Only)

The highly accurate five-pulse-per-second output is provided for applications requiring precise timing measurements. After the initial position fix has been calculated, the GPS 18-5Hz generates the pulse signal, which continues until power down. The rising edge of the signal is aligned to the start of each GPS second within 1 µs for all conditions in which the receiver has reported a valid and accurate position for at least the previous 4 seconds.

The NMEA 0183 sentences that follow each rising edge of the Measurement Pulse Output signal tell when and where you were at that previous rising edge of the Measurement Pulse Output signal, beginning with the GPRMC sentence as the lead sentence in any particular NMEA 0183 record.

Regardless of the selected baud rate, the information transmitted by the GPS 18-5Hz is referenced to the preceding five times per-second output pulse.

The accuracy of the five-pulse-per-second output is maintained only while the GPS 18-5Hz can compute a valid position fix. To obtain the most accurate results, the five-pulse-per-second output should be calibrated against a local time reference to compensate for cable and internal receiver delays and the local time bias.
The default pulse width is 100 ms, however; it may be programmed in 20 ms increments between 20 ms and 180 ms as described in $PGRMC Section 4.1.2 Sensor Initialization Information (PGRMI), field <13>.

APPENDIX A: EARTH DATUM LIST

The following is a list of the Garmin GPS 18 Earth datum indices and the corresponding earth datum name (including the area of application):

0  ADINDAN–Ethiopia, Mali, Senegal, Sudan
1  AFGOYE–Somalia
2  AIN EL ABD 1970–Bahrain Island, Saudi Arabia
3  ANNA 1 ASTRO 1965–Cocos Island
4  ARC 1950–Botswana, Lesotho, Malawi, Swaziland, Zaire, Zambia, Zimbabwe
5  ARC 1960–Kenya, Tanzania
6  ASCENSION ISLAND 1958–Ascension Island
7  ASTRO BEACON “E”–Iwo Jima Island
8  AUSTRALIAN GEODETIC 1966–Australia, Tasmania Island
9  AUSTRALIAN GEODETIC 1984–Australia, Tasmania Island
10 ASTRO DOS 71/4–St. Helena Island
11 ASTRONOMIC STATION 1952–Marcus Island
12 ASTRO B4 SOROL ATOLL–Tern Island
13 BELLEVUE (IGN)–Efate and Erromango Islands
14 BERMUDA 1957–Bermuda Islands
15 BOGOTA OBSERVATORY–Colombia
16 CAMPO INCHAUSPE–Argentina
17 CANTON ASTRO 1966–Phoenix Islands
18 CAPE CANAVERAL–Florida, Bahama Islands
19 CAPE–South Africa
20 CARTHAGE–Tunisia
21 CHATHAM 1971–Chatham Island (New Zealand)
22 CHUA ASTRO–Paraguay
23 CORREGO ALEGRE–Brazil
24 DJAKARTA (BATAVIA)–Sumatra Island (Indonesia)
25 DOS 1968–Gizo Island (New Georgia Islands)
26 EASTER ISLAND 1967–Easter Island
27 EUROPEAN 1950–Austria, Belgium, Denmark, Finland, France, Germany, Gibraltar, Greece, Italy, Luxembourg, Netherlands, Norway, Portugal, Spain, Sweden, Switzerland
28 EUROPEAN 1979–Austria, Finland, Netherlands, Norway, Spain, Sweden, Switzerland
29 FINLAND HAYFORD 1910–Finland
30 GANDAJIKA BASE–Republic of Maldives
31 GEODETIC DATUM 1949–New Zealand
32 ORDNANCE SURVEY OF GREAT BRITAIN 1936–England, Isle of Man, Scotland, Shetland Islands, Wales
33 GUAM 1963–Guam Island
34  GUX 1 ASTRO–Guadalcanal Island
35  HJORSEY 1955–Iceland
36  HONG KONG 1963–Hong Kong
37  INDIAN–Bangladesh, India, Nepal
38  INDIAN–Thailand, Vietnam
39  IRELAND 1965–Ireland
40  ISTS O73 ASTRO 1969–Diego Garcia
41  JOHNSTON ISLAND 1961–Johnston Island
42  KANDAWALA–Sri Lanka
43  KERGUELEN ISLAND–Kerguelen Island
44  KERTAU 1948–West Malaysia, Singapore
45  L.C. 5 ASTRO–Cayman Brac Island
46  LIBERIA 1964–Liberia
47  LUZON–Mindanao Island
48  LUZON–Philippines (excluding Mindanao Island)
49  MAHE 1971–Mahe Island
50  MARCO ASTRO–Salvage Islands
51  MASSAWA–Eritrea (Ethiopia)
52  MERCHICH–Morocco
53  MIDWAY ASTRO 1961–Midway Island
54  MINNA–Nigeria
55  NORTH AMERICAN 1927–Alaska
56  NORTH AMERICAN 1927–Bahamas (excluding San Salvador Island)
57  NORTH AMERICAN 1927–Central America (Belize, Costa Rica, El Salvador, Guatemala, Honduras, Nicaragua)
58  NORTH AMERICAN 1927–Canal Zone
59  NORTH AMERICAN 1927–Canada (including Newfoundland Island)
60  NORTH AMERICAN 1927–Caribbean (Barbados, Caicos Islands, Cuba, Dominican Republic, Grand Cayman, Jamaica, Leeward Islands, Turks Islands)
61  NORTH AMERICAN 1927–Mean Value (CONUS)
62  NORTH AMERICAN 1927–Cuba
63  NORTH AMERICAN 1927–Greenland (Hayes Peninsula)
64  NORTH AMERICAN 1927–Mexico
65  NORTH AMERICAN 1927–San Salvador Island
66  NORTH AMERICAN 1983–Alaska, Canada, Central America, CONUS, Mexico
67  NAPARIMA, BWI–Trinidad and Tobago
68  NAHRWAN–Masirah Island (Oman)
69  NAHRWAN–Saudi Arabia
70  NAHRWAN–United Arab Emirates
71  OBSERVATORIO 1966–Corvo and Flores Islands (Azores)
72  OLD EGYPTIAN–Egypt
<table>
<thead>
<tr>
<th>Code</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>73</td>
<td>OLD HAWAIIAN–Mean Value</td>
</tr>
<tr>
<td>74</td>
<td>OMAN–Oman</td>
</tr>
<tr>
<td>75</td>
<td>PICO DE LAS NIEVES–Canary Islands</td>
</tr>
<tr>
<td>76</td>
<td>PITCAIRN ASTRO 1967–Pitcairn Island</td>
</tr>
<tr>
<td>77</td>
<td>PUERTO RICO–Puerto Rico, Virgin Islands</td>
</tr>
<tr>
<td>78</td>
<td>QATAR NATIONAL–Qatar</td>
</tr>
<tr>
<td>79</td>
<td>QORNOQ–South Greenland</td>
</tr>
<tr>
<td>80</td>
<td>REUNION–Mascarene Island</td>
</tr>
<tr>
<td>81</td>
<td>ROME 1940–Sardinia Island</td>
</tr>
<tr>
<td>82</td>
<td>RT 90–Sweden</td>
</tr>
<tr>
<td>83</td>
<td>PROVISIONAL SOUTH AMERICAN 1956–Bolivia, Chile, Colombia, Ecuador, Guyana, Peru, Venezuela</td>
</tr>
<tr>
<td>84</td>
<td>SOUTH AMERICAN 1969–Argentina, Bolivia, Brazil, Chile, Colombia, Ecuador, Guyana, Paraguay, Peru, Venezuela, Trinidad and Tobago</td>
</tr>
<tr>
<td>85</td>
<td>SOUTH ASIA–Singapore</td>
</tr>
<tr>
<td>86</td>
<td>PROVISIONAL SOUTH CHILEAN 1963–South Chile</td>
</tr>
<tr>
<td>87</td>
<td>SANTO (DOS)–Espiritu Santo Island</td>
</tr>
<tr>
<td>88</td>
<td>SAO BRAZ–Sao Miguel, Santa Maria Islands (Azores)</td>
</tr>
<tr>
<td>89</td>
<td>SAPPER HILL 1943–East Falkland Island</td>
</tr>
<tr>
<td>90</td>
<td>SCHWARZECK–Namibia</td>
</tr>
<tr>
<td>91</td>
<td>SOUTHEAST BASE–Porto Santo and Madeira Islands</td>
</tr>
<tr>
<td>92</td>
<td>SOUTHWEST BASE–Faial, Graciosa, Pico, Sao Jorge, and Terceira Islands (Azores)</td>
</tr>
<tr>
<td>93</td>
<td>TIMBALAI 1948–Brunei and East Malaysia (Sarawak and Sabah)</td>
</tr>
<tr>
<td>94</td>
<td>TOKYO–Japan, Korea, Okinawa</td>
</tr>
<tr>
<td>95</td>
<td>TRISTAN ASTRO 1968–Tristan da Cunha</td>
</tr>
<tr>
<td>96</td>
<td>User defined earth datum</td>
</tr>
<tr>
<td>97</td>
<td>VITI LEVU 1916–Viti Levu Island (Fiji Islands)</td>
</tr>
<tr>
<td>98</td>
<td>WAKE-ENIWETOK 1960–Marshall Islands</td>
</tr>
<tr>
<td>99</td>
<td>WORLD GEODETIC SYSTEM 1972</td>
</tr>
<tr>
<td>100</td>
<td>WORLD GEODETIC SYSTEM 1984</td>
</tr>
<tr>
<td>101</td>
<td>ZANDERIJ–Surinam</td>
</tr>
<tr>
<td>102</td>
<td>CH-1903–Switzerland</td>
</tr>
<tr>
<td>103</td>
<td>Hu-Tzu-Shan</td>
</tr>
<tr>
<td>104</td>
<td>Indonesia 74</td>
</tr>
<tr>
<td>105</td>
<td>Austria</td>
</tr>
<tr>
<td>106</td>
<td>Potsdam</td>
</tr>
<tr>
<td>107</td>
<td>Taiwan–modified Hu-Tzu-Shan</td>
</tr>
<tr>
<td>108</td>
<td>GDA–Geocentric Datum of Australia</td>
</tr>
<tr>
<td>109</td>
<td>Dutch</td>
</tr>
</tbody>
</table>
APPENDIX B: BINARY PHASE OUTPUT FORMAT

In binary phase output mode, GPS 18 series products will transmit two types of packets once per second. One record contains primarily post-process information such as position and velocity information. The second record contains receiver measurement information. For the GPS 18 PC, GPS 18 LVC, and GPS 18-5Hz, the records are sent at a default baud rate of 9600 baud, 8 data bits, and no parity.

To turn these records on for the GPS 18 PC, GPS 18 LVC, and GPS 18-5Hz versions, use the $PGRMC1 NMEA sentence as described in Section 4 GPS 18 PC, GPS 18 LVC, & GPS 18-5Hz Software Interface. Refer to the Garmin Device Interface Specification for details on how to form and parse Garmin packets. At the time of this printing, these specs are available from the technical support section of our Web site: http://www.garmin.com/support/commProtocol.html.

Note: For the GPS 18-5Hz, a baud rate of 9600 is not high enough to transmit all of the packets (since they are output at a 5 Hz rate). You will need to change the baud rate to at least 38400 to be able to transmit all of the packets. Refer to Appendix C: Changing the Baud Rate in Garmin Mode for information.

For the GPS 18 USB, the two records must be enabled independently by commands to the unit. Refer to the Garmin Device Interface Specification for details on how to form and parse Garmin packets over USB. At the time of this printing, these specs are available from the technical support section of our Web site: http://www.garmin.com/support/commProtocol.html. The ID of each command should be 10 decimal to signify that the record is a command. The data portion of the packet should be one of the following:

<table>
<thead>
<tr>
<th>Function</th>
<th>Command (base 10)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position Record On</td>
<td>49</td>
</tr>
<tr>
<td>Position Record Off</td>
<td>50</td>
</tr>
<tr>
<td>Receiver Measurement Record On</td>
<td>110</td>
</tr>
<tr>
<td>Receiver Measurement Record Off</td>
<td>111</td>
</tr>
</tbody>
</table>

Note that the satellite data information is also enabled when the position record is enabled.

Records sent over RS232 begin with a delimiter byte (10 hex). The second byte identifies the record type (33 hex for a position record, 34 hex for a receiver measurement and 72 hex for a satellite data record). The third byte indicates the size of the data. The fourth byte is the first byte of data. The data is then followed by a checksum byte, a delimiter byte (10 hex), and an end-of-transmission character (03 hex). Additionally, any DLEs (0x10) that appear between the delimiters are escaped with a second DLE. There is sample code at the end of this section that will strip off the DLEs and ETXs.

RS232 Packet:
- 0x10  (DLE is first byte)
- 0x##  (Record ID – single byte)
- 0x##  (Number of data bytes – single byte)
- data bytes
- 0x##  (2’s complement of the arithmetic sum of the bytes between the delimiters)
- 0x10  (DLE)
- 0x03  (ETX is last byte)

USB packets contain only the record ID, size, and data payload. Refer to the Garmin Device Interface Specification for details on how to form and parse Garmin USB packets.

USB Packet:
- 0x##  (Record ID – single byte)
- 0x##  (Number of data bytes – single byte)
- data bytes

The data bytes of each packet contain the record specified by the record ID. A description of each record follows.
**Satellite Data Record**

The satellite data has a record ID of 0x72 with 84 (0x54) data bytes. The data bytes contain the data for the 12 channels as described below. For each satellite, the following data is available:

typedef struct {
    uint8 svid; //space vehicle identification (1–32 and 33–64 for WAAS)
    uint16 snr; //signal-to-noise ratio
    uint8 elev; //satellite elevation in degrees
    uint16 azmth; //satellite azimuth in degrees
    uint8 status; //status bit-field
} cpo_sat_data;

The status bit field represents a set of booleans described below:

<table>
<thead>
<tr>
<th>Bit</th>
<th>Meaning when bit is one (1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>The unit has ephemeris data for the specified satellite.</td>
</tr>
<tr>
<td>1</td>
<td>The unit has a differential correction for the specified satellite.</td>
</tr>
<tr>
<td>2</td>
<td>The unit is using this satellite in the solution.</td>
</tr>
</tbody>
</table>

This pattern is repeated for all 12 channels for a total of 12 X 7 bytes = 84 (0x54) bytes :

typedef struct {
    cpo_sat_data
    cpo_sat_data
    cpo_sat_data
    cpo_sat_data
    cpo_sat_data
    cpo_sat_data
    cpo_sat_data
    cpo_sat_data
    cpo_sat_data
    cpo_sat_data
    cpo_sat_data
    cpo_sat_data
} cpo_all_sat_data

The RS-232 Packet for the Satellite Record looks like:

- 0x10 (DLE is first byte)
- 0x72 (Record ID – single byte)
- 0x54 (Number of data bytes – single byte)
- cpo_all_sat_data
- 0x## (2’s complement of the arithmetic sum of the bytes between the delimiters)
- 0x10 (DLE)
- 0x03 (ETX is last byte)
The USB Packet for the Satellite Record looks like:
- 0x72 (Record ID – single byte)
- 0x54 (Number of data bytes – single byte)
- cpo_all_sat_data

**Position Record**

The Position Record has a record identifier of

```c
typedef struct {
    float alt;
    float epe;
    float eph;
    float epv;
    int fix;
    double gps_tow;
    double lat;
    double lon;
    float lon_vel;
    float lat_vel;
    float alt_vel;
    float msl_hght;
    int leap_sec;
    long grmn_days;
} cpo_pvt_data;
```

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>alt</td>
<td>Ellipsoid altitude (meters)</td>
</tr>
<tr>
<td>epe</td>
<td>Est pos error (meters)</td>
</tr>
<tr>
<td>eph</td>
<td>Pos err, horizontal (meters)</td>
</tr>
<tr>
<td>epv</td>
<td>Pos err, vertical (meters)</td>
</tr>
<tr>
<td>fix</td>
<td>0 = no fix; 1 = no fix; 2 = 2D; 3 = 3D; 4 = 2D differential; 5 = 3D differential; 6 and greater = not defined</td>
</tr>
<tr>
<td>gps_tow</td>
<td>GPS time of week (sec)</td>
</tr>
<tr>
<td>lat</td>
<td>Latitude (radians)</td>
</tr>
<tr>
<td>lon</td>
<td>Longitude (radians)</td>
</tr>
<tr>
<td>lon_vel</td>
<td>Longitude velocity (meters/second)</td>
</tr>
<tr>
<td>lat_vel</td>
<td>Latitude velocity (meters/second)</td>
</tr>
<tr>
<td>alt_vel</td>
<td>Altitude velocity (meters/second)</td>
</tr>
<tr>
<td>msl_hght</td>
<td>Mean sea level height (meters)</td>
</tr>
<tr>
<td>leap_sec</td>
<td>UTC leap seconds</td>
</tr>
<tr>
<td>grmn_days</td>
<td>Garmin days (days since December 31, 1989)</td>
</tr>
</tbody>
</table>
typedef struct
{
    unsigned long cycles;
    double pr;
    unsigned int phase;
    char slp_dtct;
    unsigned char snr_dbhz;
    char svid;
    char valid;
} cpo_rcv_sv_data;

typedef struct
{
    double rcvr_tow;
    int rcvr_wn;
    cpo_rcv_sv_data sv[12];
} cpo_rcv_data;

rcvr_tow  Receiver time of week (seconds)
rcvr_wn  Receiver week number
cycles  Number of accumulated cycles
pr  Pseudorange (meters)
phase  To convert to (0 to 359.999) multiply by 360.0 and divide by 2048.0
slp_dtct  0 = no cycle slip detected; non-zero = cycle slip detected
snr_dbhz  Signal strength - db Hz
svid  Satellite number (0 to 31; 119 to 138 for WAAS). Note: add 1 to offset to current svid numbers.
valid  0 = information not valid; non-zero = information valid
DLE and ETX bytes:
Sample C code to receive the two records should filter DLE and ETX bytes as described below:

```c
typedef enum
{
    DAT,
    DLE,
    ETX
} rx_state_type;

/* Declare and initialize static variables */
static char in_que[256];
static int in_que_ptr = 0;
static rx_state_type rx_state = DAT;

void add_to_que( char data )
{
    #define DLE_BYTE 0x10
    #define ETX_BYTE 0x03

    if ( rx_state == DAT )
    {
        if ( data == DLE_BYTE )
        {
            rx_state = DLE;
        }
        else
        {
            in_que[ in_que_ptr++ ] = data;
        }
    }
    else if ( rx_state == DLE )
    {
        if ( data == ETX_BYTE )
        {
            rx_state = ETX;
        }
        else
        {
            rx_state = DAT;
            in_que[ in_que_ptr++ ] = data;
        }
    }
    else if ( rx_state == ETX )
    {
        if ( data == DLE_BYTE )
        {
            rx_state = DLE;
        }
    }

    if ( in_que_ptr > 255 )
    {
        in_que_ptr = 0;
    }
}
```

APPENDIX C: CHANGING THE BAUD RATE IN GARMIN MODE

In certain cases, you may need to change the default baud rate of your Garmin GPS receiver while in Garmin mode. Follow these steps to temporarily change the baud rate.

Refer to the Garmin Device Interface Specification for details on how to form and parse Garmin packets. At the time of this printing, these specs are available from the technical support section of our Web site: http://www.garmin.com/support/commProtocol.html.

1. Turn off all requests by transmitting packet:
   id = IOP_RQST_DATA (0x1C)
   data = 0 (16-bit unsigned integer)

2. The GPS unit will respond by sending a packet with id = IOP_ACK_BYTE (0x06)

3. After you receive the above packet, transmit packet:
   id = IOP_BAUD_RQST_DATA (0x30)
   data = baud rate to change to (32-bit unsigned integer; for example, 38400)

4. The GPS unit will respond by sending a packet:
   id = IOP_BAUD_ACPT_DATA (0x31)
   data = highest acceptable baud rate closest to what was requested
         (32-bit unsigned integer; for example, 38361 decimal)

5. Determine the actual baud rate value from the data sent in step 4. This value will be within +/- 5% of the actual baud rate. (For example, the GPS unit might send a baud rate of 38361, which correlates to a baud rate of 38400).

6. If the baud rate in step 5 is acceptable, transmit packet:
   id = IOP_ACK_BYTE (0x06)
   data = IOP_BAUD_ACPT_DATA (0x31)

7. Sleep for a small amount of time, about 100 milliseconds, to make sure the packet in (6) was successfully transmitted to the GPS unit.

8. Close the current connection to the GPS unit and immediately open a new connection with the new baud rate obtained in step 5.

9. Immediately after establishing a connection, transmit packet:
   id = IOP_CMND_DATA (0x0A)
   data = IOP_ACK_PING (0x3A)

10. The GPS will respond by sending a packet:
     id = IOP_ACK_BYTE (0x06)
         data = IOP_CMND_DATA (0x0A)

11. After you receive the above packet, transmit the same packet in step 9 again.
     id = IOP_CMND_DATA (0x0A)
         data = IOP_ACK_PING (0x3A)

12. The GPS will respond again with the same packet in step 10.
     id = IOP_ACK_BYTE (0x06)
         data = IOP_CMND_DATA (0x0A)

13. The baud rate has been successfully changed upon receiving the above packet. If the GPS unit does not receive these two IOP_CMND_DATA packets within two seconds, it will reset its baud rate to 9600.
APPENDIX D: GPS 18 PC/ LVC/18-5Hz & WINDOWS SERIAL MOUSE ISSUE

Problem: It is possible for Windows to incorrectly interpret the NMEA 0183 output of the GPS 18 PC as the output of a Microsoft Serial BallPoint Mouse. When that happens, Windows loads drivers for the Serial BallPoint Mouse. This causes the cursor to move erratically about the display, clicking, right clicking, double clicking, dragging and dropping displayed items as it goes. On Windows 2000 and Windows XP, you may not experience the problem if you wait until after the computer is booted before connecting the GPS 18 PC to the serial communications port. This problem is not specific to the GPS 18 PC. Any NMEA 0183 device connected to a Windows computer’s serial port is likely to cause this problem. Below are several possible solutions to this problem.

Note: If your GPS 18 PC came with Garmin nRoute™ Navigation Software, you will not have this problem; the unit is programmed to produce data according to the binary format that is described in Appendix B: Binary Phase Output Format.

If you wish to use a different navigation software application with your GPS 18 PC, you will need to de-select the “Phase Output Data” option that is discussed in Solution 3 below.

Solution 1: The easiest solution is to disable the Serial BallPoint mouse in the Device Manager. Of course, this solution assumes that you do not need to use a Serial BallPoint mouse with your computer. When the wild mouse problem occurs follow the steps below.

1. Unplug the DB9 connector.
2. Right-click the My Computer icon on your desktop and select Properties to open Device Manager.
3. Go to the hardware tab of the resulting pop-up window and click on the Device Manager button.
4. Right-click on Serial BallPoint Mouse and choose the option to Disable (NOT uninstall) this device.

Solution 2: Do not plug the DB9 connector into the computer until the computer is turned on and the operating system is completely booted up and running. Every time you use the GPS 18 PC/LVC, you will need to start the computer and operating system before making the connection between the GPS 18 PC and the computer. This solution usually works on Windows 2000 and Windows XP computers.

Solution 3: Change the default output of the GPS 18 PC/LVC so that it does not automatically send NMEA 0183 data to the computer (change the default configuration to enable “Phase Output Data”). Use the Garmin Sensor Configuration Software, named SNSRCFG.EXE, provided on the Web site to enable “Phase Output Data.” SNSRCFG.EXE is included with the latest GPS 18 firmware, available at http://www.garmin.com/support/agree.jsp?product=010-00321-05.

Please note that by enabling “Phase Output Data,” the device will no longer appear as a NMEA 0183 device to your computer. As a result, mapping applications that expect to hear NMEA 0183 data will not recognize your GPS 18 P/LVC until you re-enable the NMEA 0183 output, disabling the “Phase Output Data” in the process.

Refer to Appendix E: Sensor Configuration Software for complete information about downloading the Sensor Configuration Software application.

After the Sensor Configuration Software is installed and running on your computer, follow the steps below to change the default data output of the GPS 18 PC, LVC, or 18-5Hz.

1. Select the GPS 18 PC / LVC or the GPS 18-5Hz from the list of sensors and click OK. The Sensor Configuration Software opens with the default configuration file for the GPS 18, as shown on the next page.
2. Select Config > Switch to NMEA Mode (or press the F10 key).
3. Select Comm > Setup to open the Comm Setup Window.
4. Select the Serial Port to which the GPS 18 is connected. Select Auto to have the program automatically determine the Baud Rate, or select Manual to manually select the Baud Rate of the GPS 18. Click OK when done.

5. Click the Connect icon or select Comm > Connect to connect to the GPS 18.

6. To view the current programming of the GPS 18, select Config > Get Configuration from GPS (or press the F8 key). The current programming of the GPS 18 is displayed in the window, as shown on the previous page.

7. Open the Sensor Configuration Window by pressing the F6 key or selecting Config > Sensor Configuration.

8. Place a check mark in the box next to “Binary Output Data” to change the GPS 18 to Garmin Mode. The unit will keep this change in the programming until you change it again in the software.

   Note: Selecting Config > Switch to Garmin Mode (or pressing the F11 key) only changes the unit to work in Garmin Mode until power is cycled through the unit again. For a more permanent change, refer to step 8 above.

9. Click OK.

10. When you are ready to upload the changes into the GPS 18, select Config > Send Configuration to GPS (or press the F9 key). The new configuration is then loaded into the GPS 18.

11. You may disconnect and close the software when finished. The software configuration can also be saved for future reference.

Refer to Appendix E: Sensor Configuration Software for complete information about downloading the Sensor Configuration Software application.
APPENDIX E: SENSOR CONFIGURATION SOFTWARE

SNSRCFG configures the GPS sensors based on user-selected parameters. Some application features include the ability to download GPS sensor configuration, maintain different configurations in files, and perform GPS sensor configurations quickly with the use of one function key.

This section provides a brief overview of the Sensor Configuration Software. Refer to this section when using the software to configure your Garmin sensor.

Downloading the Sensor Configuration Software

The Garmin Sensor Configuration Software (SNSRCFG.exe) is available from the Garmin Web site. To download the software, start at http://www.garmin.com/oem, select the GPS 18, and then select Software Updates. The Garmin Sensor Configuration Software (SNSRCFG.exe) is included in the software update download.

Selecting a Model

After opening the program (snsrcfg.exe), the following screen appears. Select the radio button next to the type of Garmin sensor you are configuring.

Connecting to the Sensor

After selecting the type of sensor, the following window opens. This is the Main Interface Screen for the program.

To configure your sensor, you must first connect to the sensor.

1. Select **Config > Switch to NMEA Mode** (or press the F10 key).
2. Select **Comm > Setup** to open the Comm Setup Window.
3. Select the Serial Port to which the sensor is connected. Select **Auto** to have the program automatically determine the Baud Rate, or select **Manual** to manually select the Baud Rate of the GPS 18. Click **OK** when done.
4. Click the Connect icon or select **Comm > Connect**.
5. To view the current programming of the sensor, select **Config > Get Configuration from GPS** (or press the F8 key). The current programming of the sensor is displayed in the window shown to the right.
File Menu
The File Menu allows you to open, save, and print sensor configurations. The items in the File Menu work like most Windows-based programs.

Comm Menu
The Comm (Communication) Menu allows you to set the port number, baud rate, and then connect and disconnect from the sensor.

Setup: Opens the Comm Setup Window, shown to the left. Select the Serial Port to which the sensor is connected from the drop-down list. Then select Auto (the program determines the baud rate on its own) or Manual (you then enter the baud rate) for the Baud Rate entry.

Connect: Select Connect to connect to the sensor to change or view the configuration.

Disconnect: Select Disconnect to disconnect from the sensor.

Config Menu
The Config (Configuration) Menu allows you configure the sensor as it is connected.

Sensor Configuration (F6): Opens the Sensor Configuration Window, shown to the right. Many of the fields in this window should be left alone. Please refer to the beginning of this manual for clarification about some of these fields. For the most part, this window is used to enter a new Latitude, Longitude, and Altitude for the sensor. This is especially helpful when you are programming the sensor for use in a particular geographic location.

Resetting the Unit (Reset Unit) performs a reset on the unit, much like cycling the power.

Resetting the non-volatile memory (Reset NonVol) will clear all of the data from the non-volatile memory.

NMEA Sentence Selections (F7): Displays the NMEA Sentence Selections Window. If the sentence is enabled, a check mark appears in the box to the left of the sentence name. Click the box to enable or disable the sentence.
**Get Configuration From GPS (F8):** Retrieves the current programming from the sensor. The programming is then displayed in the Main Interface Window.

**Send Configuration To GPS (F9):** Sends the changes you have made to the programming to the sensor.

**Switch to NMEA Mode (F10):** Switches the unit to NMEA Mode. The sensor must be in NMEA Mode when connected to this software.

**Switch to Garmin Mode (F11):** Switches the unit to Garmin Mode.

**Update Software (F12):** After you have downloaded a new software version for the sensor, you can update the sensor with the new software. Select Update Software and then select the file using the Open dialog box. You must locate both the *.rgn file and the updater.exe file.

**View Menu**
The View Menu allows you to view the NMEA sentences transmitted by the sensor. You can also customize how the program looks by showing and hiding the Toolbar and Status Bar.

**Help Menu**
The Help Menu displays the software version and copyright information.

---

For the latest free software updates (excluding map data) throughout the life of your Garmin products, visit the Garmin Web site at www.garmin.com.